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ACE+ Suite V2010.0 Release Notes 

 

ACE+ Suite V2010.0 
この文書は，ACE+ Suite V2010.0 アプリケーションのリリース案内です．本書に於いて 2008 年 12
月の V2009.４以降に加えられた新機能と改善点，修正された不具合について記述します． 

ACE+ Suite of applications 

ACE+ Suite は，先進のマルチフィジックス解析に必要なツールを仮想プロトタイプ環境で提供するアプリケー

ションパッケージです．ACE+ Suite には以下のアプリケーションを含みます． 

 

CFD-GEOM CFD-VIEW 

CFD-VisCART CFD-CADalyzer 

CFD-ACE+ CFD-TOPO 

CFD-FASTRAN SimManager 

 

Supported Platforms  

ACE+ Suite V2010.0 は以下のプラットフォームをサポートします:  

プラットフォーム パッケージ名 

Windows XP/2003/Vista/2008/Win7 on Intel or AMD (32-bit) pc-windows-nt5-x86 

Windows XP/2003/Vista/2008/Win7 on Intel or AMD (64-bit) pc-windows-nt5-x86_64 

Linux RedHat Enterprise 4+ on Intel or AMD (32-bit)  pc-linux-rhe4-x86 

Linux RedHat Enterprise 4+ on Intel or AMD (64-bit)  pc-linux-rhe4-x86_64 

Linux RedHat Enterprise 5+ on Intel or AMD (32-bit)  pc-linux-rhe5-x86 

Linux RedHat Enterprise 5+ on Intel or AMD (64-bit)  pc-linux-rhe5-x86_64 

Linux Suse 10 on Intel or AMD (32-bit)  pc-linux-suse10-x86 

Linux Suse 10 on Intel or AMD (64-bit)  pc-linux-suse10-x86_64 

Linux Suse 9 on SGI Altix (64-bit)  sgi-linux-suse9-ia64 

注: 

 AMD Athlon プロセッサと Intel Pentium III プロセッサは SSE2 未対応のため、ACE+ Suite V2020.0

はこれらに対応しません． 

 CFD-GEOM は Linux Suse 9 (64-bit)には対応しません． 

 CFD-CADalyzer は Windows (32-bit/64-bit)のみ対応しています． 

 CFD-TOPO ソルバは Linux Suse 9 (64-bit) と Linux Suse 10 (32-bit and 64-bit)には対応しません． 

  WEB ブラウザ: オンラインヘルプは Internet Explorer 6 以降 (MS-Windows) ，Netscape 6 以降 

(MS-Windows, Linux) そして Firefox 3 以降(MS-Windows, Linux)で開くことができます．Google 

Chrome は推奨しません． 
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後方互換性 

以下に述べる CFD-GEOM V2006（以前の）スクリプトに関連した問題を除いて，ACE+ Suite アプリケーション

は後方互換性に問題ありません． 

CFD-GEOM V2007.6 でのソフトのコア部分の変更により，Python 機能が大きく変更されたため，Python スク

リプトの後方互換性が維持できなくなりました．つまり，CFD-GEOM V2007.6 以降のバージョンは V2006 以前

の Python スクリプトはいずれも実行出来ません．これは望ましくないことですが，CFD-GEOM の向上にとっ

て必要な変更でした．もし V2006 以前のスクリプトを使用したい場合は，以下の方法で対応してください 

1. CFD-GEOM V2006 をインストールしておき，V2006 のスクリプトを使用する際には，V2006 の CFD-

GEOM を使用します．ライセンスは，V2010.0 と V2006 を含む旧バージョンのどちらも起動できます．

最新の CFD-ACE と CFD-FASTRAN は V2006 の GEOM で作成した DTF を問題なく実行できます． 

2. V2006 のスクリプトを V2010.0 フォーマットに変換してください．V2006 のスクリプトファイルを手作業

で V2010.0 のスクリプト言語に書き変えることになりますが，V2010.0 以降の構文に相当する関数に

置き換えるだけで，プログラムの構造はそのまま使用できます．構文に関する不明点はお問合せく

ださい． 

 

新しいディレクトリ構成と旧バージョンの起動 

V2009.4 以前のバージョンでは，アプリケーションは$ESI_HOME ディレクトリの直下に置かれ，たとえば

GEOM_2009.4 のように，「（アプリケーション名）_（バージョン番号）」のディレクトリ名になっていました．  

V2010.0 リリースより，$ESI_HOME ディレクトリの下に 2010.0 ディレクトリを作成し， その 2010.0 ディレクトリ

下にすべての ACE+ Suite V2010.0 アプリケーションディレクトリを展開するよう変更しました．アプリケーショ

ンディレクトリの名前は，たとえば GEOM のように「（アプリケーション名）」となっています． 

従って，CFD-GEOM アプリケーションディレクトリは，以下のようになります．  

V2009.4 では，$ESI_HOME/GEOM_2009.4 

V2010.0 では，$ESI_HOME/2010.0/GEOM 

今後，このバージョンごとに分けたディレクトリ構成を用います．この新しいディレクトリ構成は，ESI_software 

ディレクトリに 2009.4, 2009.2, 2009.0, 2008.2, 2008.0, 2007.2, 2007, 2006, 2004 バージョンがインストールされ

ている環境でも問題ありません．ユーザは新旧バージョンを併用できます．ユーザが 2009.4, 2009.2, 2009.0, 

2008.2, 2008.0, 2007.2, 2007, 2006, 2004 バージョンがインストールされた環境で使用する場合は，環境変数 

PATH を先頭に最も新しい UTILS ディレクトリ（つまり$ESI_HOME/2010.0/UTILS/bin）が指定されるよう変更

します．そして，旧バージョンのソフトウェアを使用する場合は –runver （バージョン番号）オプションを使って

ください．例えば Linux/UNIX において sh, bash 等を使用している場合には以下の様になります: 

% export PATH=$ESI_HOME/2010.0/UTILS/bin:$PATH (Bourne-type shell 構文) 

% CFD-GEOM –runver 2009.4         (CFD-GEOM V2009.4 起動) 
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新機能と改良点  

CFD-GEOM V2010.0 には，V2009.4 以降で開発された新機能および施された修正点が反映されています．

以下にこれらについて記述します． 

 

V2010.0 

境界層メッシュ生成機能の向上                                               

V2009.2 において，境界層メッシュ生成機能が大幅に改善されました．これにより，生成可能な領域にのみ境

界層メッシュを生成し，問題のある領域ではその生成を行わないということが可能になりました．これまでは，

何か問題があると全ての境界層メッシュの生成が中止され，境界層メッシュが全く生成されない場合がありま

した．以下の図を使用してこの改善を示します．最初の図（以前のバージョン）では，境界層メッシュが 3 層の

み作成されています．それに対し，2 番目の図（本バージョン）では，境界の大部分で境界層メッシュが 9 層生

成されているのが分かります． 

 

 

 

V2010.0 では，この境界層メッシュ生成アルゴリズムの効率が向上しました．これにより前バージョンと比較し

て最大３倍の速度向上がのぞめます． 

 

Advancing Front Surface Meshing の改善                                      

V2009.2 において，Advancing front surface meshing のアルゴリズムのロバスト性が大きく改善されました．ア

ルゴリズムの変更により，大きな表面曲率をもつサーフェスや，境界の長さが大きく異なるサーフェスの扱い

が改善されました．さらに，サーフェス内部の表面曲率を解像するオプションが新たに追加されました．以下

の図に例を示します．左側が元のサーフェスで，右側がこの機能を使用して改めてメッシュを作成し直したサ

ーフェスを示しています． 
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V2010.0 において，Advancing front surface meshing アルゴリズムが更に改善されました．この改善により約

10-20%の速度向上およびロバスト性向上が達成されました． 

 

CAD/IGES データ読み込み機能の改善                                                                   

V2009.2 において，CAD と IGES ファイルの読み込み機能が改善されました．サーフェスが正しく作成される

様に Closed/periodic Surface への対応が強化されました．CAD インポート機能の改善に伴いデータの読み

込みにかかる時間が，約 70%短縮されました． 

V2010.0 において，IGES データの読み込み機能が強化され、IGES5.3 スタンダードに対応します．これにより，

analytic surfaces， trimmed faces，shells，solids を含む 11 のエンティティーが新たにサポートされます．CAD

から出力された IGES 5.3 スタンダードフォーマットのデータの取り扱いが非常に容易になります． 

 

二点と半径指定による円作成新機能                                                                   

V2010.0 において，2 個のポイントと半径を指定することで円を作成する新たなツールが“Conic creation”ツー

ルボックスに加わりました． 

 

スクリプトオプションで実行した際のエラーメッセージ出力方式の変更 

V2010.0 ではこれまでのバージョンと同様，エラーメッセージや print 文の出力が View -> Script Output から

アクセスできる，Script Output Window で見ることができます．また，CFD-GEOM でスクリプトを実行する場合

に は ， geom_script_<modelname>.out 名 の フ ァ イル に 出 力 先 を 変 更 し ま す ． こ の フ ァ イル は Edit -> 

Preferences -> Files において指定された “Temporary Files Directory” に作成されます． 

以前のバージョンでは，CFD-GEOM を ”-script” オプションを使用して GUI を立ち上げずに実行した場合

にエラーメッセージがあると，Linux 環境ではそれがコンソールに出力されますが，Windows 環境ではその出

力がありませんでした．V2010.0 では OS によるこれらの違いが改善され，Windows，Linux 双方に対し， スク

リプトファイルが保存されている場所に作成される geom_script_<modelname>.out 名のファイルにエラーメッセ

ージが出力されるように変更されました．この変更に伴い Linux ではエラーメッセージはコンソールに表示さ

れなくなります． 
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修正済の問題-V2010.0 

V2010.0 で修正済の問題はありません． 

既知の問題-V2010.0 

以下は最新バージョンに付随する既知の問題です．これらは将来のリリースにて修正される予定です． 

 多面体セルを含む既存の DTF ファイルの更新：現在，多面体格子（coarsened block）を含む既存の

DTF ファイルをアップデートすることはできません．新規の DTF ファイルでは，多面体格子を含むモ

デルも書き込むことができます． 

 Edge エディタにおけるアンドゥ機能：アンドゥ機能は Edge エディタでは利用できません．ユーザが

Edge エディタセッションを終了する際にエラー状態（face の向かい合う辺の格子点の数が一致してい

ない状態）にある場合，CFD-GEOM は最新の「正しい」状態に格子を復帰させます． 

ACIS（モデリングカーネル）の対応バージョンの違い：pc-linux-rhe4-x86 と pc-linux-rhe4-x86_64 以外のプラ

ットフォームに関しては，ACIS のバージョンが 20.0.3 にアップグレードされましたが，これら 2 つのプロットフォ

ームに関しては ACIS のバージョンが 18 のままです．このため，パーフォーマンスに違いがみられる場合が

あります。 
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新機能と改良点 

CFD-VisCART V2010.0 は V2009.4 以降に開発された新機能と改良を含んでいます。 以下のこれらについ

て記述します。 

 

V2010.0 

Baffle (Thin-Wall) 取り扱いの改良                                                 

2009.2 以前のバージョンでは, baffle を作成したい場合, 対象パーツが他のパーツと完全に交わらない場合

に限り baffle を作成することができました。この制限が 2009.4 で無くなりました。 

下の図は厚みの無い円筒形状が, 厚みの有る形状に接している場合です。もしこの形状が VisCART 上で

Thin-Wall と指定された場合, メッシュ生成時に形状の表と裏で点と点を合わせることにより, Thin-Wall になる

ようなメッシュの生成が可能です。 

 

 
V2010.0 においては, baffle を取り扱うアルゴリズムにさらに改良が加えられています。ユーザーは本来なら

ば thin-wall 以外の属性(例: wall など)が指定されるパーツに対しても, thin-wall であるという設定を与えるこ

とが可能です。メッシュ生成アルゴリズムが thin-wall になるべきパーツと, wall になるべきパーツを自動認識

し, メッシュ生成後にパーツに正しい属性を付与します。※すべてのパーツが thin-walls と認識される場合に

は, マルチドメイン生成のアルゴリズムをご利用下さい。 

制限事項: 

- Thin-Wall となる形状は厚み 0 のサーフェスである必要が有ります。 

- Thin-Wall 形状を正確に捉えるためには, メッシュを作成する前にあらかじめ outline/feature を検出

しておく必要が有ります。 

 

フィーチャー捕捉に関するマルチドメイン生成スキームの改良                                     

マルチドメイン生成の機能に改良が加わり, モデルのフィーチャー捕捉能力が向上しました。この向上により

2 つのパーツ/サーフェスが成す角が 45 度以下であるような部位においても, フィーチャーが捕捉される様に

なりました。以下の比較画像もご参照下さい。 
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           以前のバージョン          V2010.0 

 

改良された解適合                                                              

V2009.2 以前のバージョンでは, 解適合のアルゴリズムは境界付近のセルには効用がありませんでした。し

かし V2009.4 以降に追加された ”Adapt Cells near Boundary” オプションにより(境界層メッシュが作成され

ていない場合は)境界付近のセルにも解適合を考慮することができる様になりました。(このオプションはメッシ

ュサイズを非一様に変更することから, 品質低下の恐れがある境界層メッシュに対しては, 適用されません。) 

V2009.4 ではバッチでも動作するようになりました。 

V2009.4 までに解適合機能はシングル領域のみに対応していましたので, 並列計算の様に領域を分割され

た様な計算対象には対応ができませんでした。V2010.0 ではシングル領域とマルチ領域を共存させ, マルチ

領域をシングル領域に自動的に写像させることによって, 並列計算にも対応できるようになりました。 

他にも V2010.0 にて以下の様な改良が加えられています: 

 解適合に関するバッチスクリプトコマンドが直感的に理解しやすい仕様になっています。詳細はバッ

チスクリプトのマニュアルを参照して下さい。 

 過去のバージョンでは解適合される前のセル中心データをプログラム上に確保していたため, メモリ

使用量が多くなりがちでしたが, V2010.0 では領域ごとに外部ファイルへ保存する仕様に変更となり

ました。この機能拡張により解適合実行中のメモリ使用量が大幅に尐なくなりました。 

※境界条件の写像は境界の名前を対応させて行うため, ユーザーは境界に付与する名前に重複が無い様

に注意する必要があります。 

 

境界層メッシュに関する改良                                  

境界層メッシュ生成アルゴリズムは V2009.2 より大幅に改良が施され,殆どの複雑な形状にも生成可能になっ

ています。改良されたルーチンはユーザーが指定した層の数を把握しつつ, 出来る限り多くの層を生成します。 

V2010.0 においては以前のバージョンより, 境界層メッシュ生成速度が 3 倍になっています。  

さらに symmetry と wall が交差する位置での品質が向上しています。 

 

球型・シリンダー型ソース                                                                   

Mesh refinement source の形状として, 新しく球型とシリンダー型が加わりました。シリンダー型においては, 

内周外周の半径, および中心軸の向きを指定することが出来ます  

パッチ上のローカルセルサイズに関する仕様改良                          

ユーザーはメッシュを細かくするために, Surface source を用いますが, V2010.0 から荒くする為にも利用でき

る様になりました。つまり, global サイズに対して大にも小にもサイズ設定が可能です。さらにこの設定は 

normal/tangential, cell size level を問わず行うことが可能です。 
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修正済みの問題点 

V2010.0 での修正点: 

 バッチコマンド 'save_decomposed_dtf' による領域分割が, ユーザーの指定した分割方向と異なって

しまう現象が有りましたが, 現在では修正済みです。 

 解適合のバッチスクリプトへ DTF ファイル名が渡される時に, CFD-VisCART が間違ったパスを認識

してしまう現象がありましたが, 現在では修正済みです。 

 マルチドメイン生成機能にて, フィーチャーライン上の全く同じ位置に 2 点のノードができ, 悪いフェイ

スを作成してしまう可能性が有りましたが, 現在では修正済みです。 

 8 ノード以上を持った直行格子の場合, スプリットが正しく動作せず, dtf_decompose にてエラーが発

生する現象が有りましたが, 現在では修正済みです。 

 サーフェスソースを作成するときに使用したパーツを消去してしまった場合, 稀にスクリプト出力機能

が正しく動作しませんでしたが, 現在では修正済みです。 

 外部境界を指定して作成されたサーフェスソースが正しく取り扱いできないケースがありましたが, 

現在では修正済みです。 

 ギャップ検知ツールにて, 指定したサイズ以上のギャップを発見することや, サイズ 0 のギャップを発

見してしまう場合がありましたが, 現在では修正済みです。 

 二重になったフェイスをマージ修正した場合にファセット面が不適切なコンテナに収められる事があり、

それによって DTF 保存に問題が生じ, dtf_decompose が失敗するケースがありましたが, 現在では

修正済みです。 

 並列によるメッシュ生成を行った際, improve_mesh コマンドの動作が停止してしまう問題がありまし

たが, 現在では修正済みです。 

 領域のセルサイズを指定した上でその領域を選択すると, CFD-VisCART がクラッシュしてしまう現

象がありましたが, 現在では修正済みです。 

 マルチドメイン生成機能にて, 外部領域の部材分けが想定と異なってしまう現象がありましたが, 現

在では修正済みです。 

 特定の Linux において, CFD-VisCART の起動時に OpenGL がクラッシュしてしまう問題がありました

が, 現在では修正済みです。 

 

既知の問題点 

 マルチドメインメッシュ生成機能において, 2 枚のサーフェスが隣接している場合, 正しくインターフェイ

スが作成されない場合があります。 

 Windows 機において CFD-VisCART –runver が動作しない現象が確認されています。 
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新機能と改良点– V2010.0 

CFD-ACE+ Solver V2010.0 

CFD-ACE+ SOLVER V2010.0 は、V2009.4 リリース以降に行われた新機能の開発、改良、バグ修正を全て

含む、V2010.0 の最初のリリース版となります。以下に、V2010.0 に加わった新機能と変更点を紹介します。  
 

V2010.0 

DOM 輻射モデルの機能拡張 – SnDOM, CAFVM                                          

CFD-ACE+ で、以前から利用できる Discrete Ordinate Method（DOM）の輻射モデルは、厳密には Sn 

Discrete Ordinate Method（または SnDOM）と呼びます。このモデルで利用できた Sn 求積法は、S4, S6, S8, 

S12（それぞれ、3D の輻射計算において、24, 48, 80, 168 の分割数を使用）ですが、デフォルトでは、S4 スキ

ームを使用しており、他のスキームを使用する際には、DTF update コマンドで指定が可能でした。 

V2010.0 では、CFD-ACE+ GUI 上で、これらのスキーム（S4, S6, S8, S12）が指定出来る様になりました。 

また、V2010.0 では、新しい DOM 手法である Control Angle Finite Volume Method (CAFVM)が新たに追加さ

れました。この手法では、ユーザーが天頂角と方位角の分割数を指定することが出来ます。ユーザーは、単

位球を離散化するための N と N （天頂角と方位角の分割数）を指定します。 

 

CAFVM による単位球の離散化 

 

計算において使われる球面座標の範囲と分割数は、以下の通りです： 

 3D: ( 0      , 0     2 ) 

o 分割数 = N N 

 2D: ( 0     /2, 0     2 ) 

o 分割数 = (N /2) N 

 2D Axisymmetric: ( 0      , 0      ) 

o 分割数 = N (N /2) 
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ユーザーは、CFD-ACE+ GUI の MO→Adv オプションで、SnDOM (Sn 求積スキーム) か、CAFVM か指定

することが出来ます。 

 

外部回路シミュレーターとプラズマのカップリング機能の拡張                                                                 

多次元形状のリアクタースケールモデルに対して、電極間電圧設定を様なプラズマプロセスの実時間制御を

与えるには、回路パラメータとプラズマ特性間の正確なカップリングが必要となります。V2010.0 では、これら

のニーズに応えるためだけでなく、高周波放電における外部回路とプラズマ特性の関係をより明らかにする

ために、Berkeley SPICE 2g6 とカップリングする電気回路モデルが開発されました。 ‘loose coupling’の手法

によって、CFD-ACE+ のプラズマソルバーはより一般的に外部回路との相互作用を明らかにすることが出来

ます。 

SPICE-ACE+カップリングオプションは、CCP モードにのみ使用出来 MO→Adv タブで設定できます。回路モ

デル使用時、ユーザーは回路に対するネットリスト入力ファイルを選択する必要があります。更に、以下の設

定が必要です。 

 Electric BC:今までのオプションは引続き使用できますが、“External Circuit” オプションは、Fixed 

Potential type BC に対して使用できます。ここで、ユーザーは netlist 入力ファイルに該当するリアク

ターBC に相当するノード番号を指定する必要があります。この方法で異なるリアクタ境界の回路を

繋げることが出来ます。 

SPICE-ACE+ オプションは、V2010.0 以前に利用できたコンデンサのみの回路モデルと併用する事は出来ま

せんが、下位互換性は維持されています。： 以前のコンデンサのみの回路モデルを使用するためには、以下

の 2 行について、special DTF update コマンド を実行します。 

 

V_float int 1 1   

Cb_per_unit_area double 1 C  

 

ここで C は、[F/m2]の単位の静電容量で、GUI 上で指定することも出来、すべての正弦波 BC に適用されま

す。 

もし、N 個の異なる正弦波 BC に対し異なる静電容量を割り当てる場合、以下の update コマンド が必要で

す。 

 

V_float int 1 1   

RF_Vsin_Cb_Num int 1 N 

RF_Vsin_Src_Freq double N f1 f2… fN 

RF_Vsin_Cb_per_Area double N C1 C2… CN 

 

f1, f2, ... fN は、正弦波境界の RF 周波数で、C1, C2, ..CN はその時の静電容量 [F/m2] です。 

 

Stochastic Heating モデルの改良                                                                    

容量結合型プラズマ (CCP) は、半導体チップ製造におけるエッチングやデポジションプロセスで頻繁に使用

されます。”Stochastic Heating” は、低圧または高周波数条件下の放電過程において、重要な役割を担う物

理現象です。前バージョンの Stochastic Heating モデルは、経験則を基づくもので、又指定困難なパラメータ

をユーザーが入力する必要がありました。V2010.0 では、新しい Stochastic Heating のモデルが CCP モデ

ルに追加されました。このモデルは、より一般的で、使用者指定のパラメータ設定無しで使用できます。この
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モデルでは、Lieberman et al. によって発表された解析式を用い、統計的シース加熱が発生するプラズマ領

域を CFD-ACE+ が自動的に認識する新しい自己認識型 アプローチが実装されました。 

このモデルは、カルフォルニア大学、バークレイの E Kawamura, I Lee らよる研究に基づいています。

Stochastic Heating によるパワーは以下の式を使用して計算されます。 

 

1

2/12

0

2/1

, 61.0 VT
e

m
S ecaps 








  

 

V1 は、局所的なプラズマセルからパワー電極までの電場の積分値（もしくは、電位の差）。 m は電子の質量、

e は電子の電荷、w はパワー電極の最大駆動角周波数、Te 電子温度です。 

このモデルは、CCP プラズマを選択している時に、CFD-ACE+ GUI MO/Adv パネルで選択することが出来

ます。この新しい導入モデルでは、CFD-ACE+ が正弦波のパワー面に接しているシース領域を見つけること

が出来ます。そして、Stochastic Heating のパワーが、上記の式を用いて計算されます。 

 

STS 輻射モデルのリスタート計算効率の改善                                  

STS 輻射モデルを使用したとき、以前のバージョンでは形態係数（形状要素、補助データなど）のデータを保

存するオプションがありませんでした。その為、これらのデータはリスタート計算を行う度に、再度計算されて

いました。形態係数の計算は、特に大きなモデルで相当の計算時間を要します。計算時間は、モデルの精度

レベルを上げる (low < moderate < high < extremely high) と更に長くなります。 

リスタート時におけるこれらの形態係数の再計算にかかる時間を省略するために、新しい機能が V2010.0 

に追加されました。最初の計算実行後ソルバーがストップすると、<filename>_sts.rst というファイルが計算実

行ファイルのあるカレントフォルダに出力されます。このファイルには、形態係数に関する情報が記録されて

います。 

リスタート時には、形態係数の再計算を行わずに、この <filename>_sts.rst ファイルから必要なデータを読み

込みます。 

<filename>_sts.rst ファイルが作業フォルダに無いときには、以下のエラーメッセージが.out ファイルに出力さ

れます。 

“STS Restart Read Error: Error Reading STS Restart File. Will Generate STS Geometric Data” 

今場合、再度ソルバーは、形態係数を計算し、解析を続けます。 

 

Fan Curve モデルの相関式指定オプションの追加                                      

CFD-ACE+ は、ファンやローター、プロペラなどの装置による時間平均の物理量をモデル化するためのアプ

ローチ方法として (i) Fan Blade Model アプローチと(ii) Fan Curve Model アプローチの 2 種類の方法を提供

しております。Fan Blade Model アプローチは、回転するブレードの効果をの幾何学的、物理的第一原理から

モデル化するのに対し、Fan Curve Model アプローチは、ファンの平面を通過した時の局所的な流量もしくは

局所的な流速と圧力ヘッドとせん断応力との相関で与えられる現象論的方法です。 

以前のバージョンでは、ユーザーは Fan Curve Model アプローチの相関を与えるために、 (i) インプットファ

イル, (ii) CFD-ACE+ GUI の”piecewise-linear profile” の入力による 2 種類の方法がありました。V2010.0 

では、これらの相関を与える新たな方法、(i) 5 次の多項式（ファンの平面を通過した時の局所的な流量もしく

は局所的な流速と圧力ヘッドとせん断応力との相関）、（ii） 一定値（圧力ヘッドもしくはせん断応力を固定）が

追加されました。更に、V2010.0 では、CFD-ACE-GUI の Fan Curve Model の設定パネルが新しくなりまし

た。 Fan Curve Model の相関に対する 2 つの新しい入力指定フォームが、ファンのメーカーや、その他の装

置によって一般的に使用されるパフォーマンスデータの形式に近い形になり、CFD-ACE+ における Fan 

Model の使いやすさや便利さが向上しました。 
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Wall 境界条件の拡張 – 局所的 Slip Wall                                                                  

特に指定が無い限り、CFD-ACE+ では、全ての Wall 境界に、no-slip 条件を適用します。連続体近似の仮

定が、全ての領域において成り立つ流れ場においてはこのデフォルト設定が最も適切です。しかし、もし連続

体近似が成り立たない領域を含んでいる場合（例えば、希薄流体、もしくは局所的な形状寸法が、平均自由

行程と同程度の時）、非連続体近似の境界条件を Wall 境界に設定する方がより正確です。CFD-ACE+ では、

Slip Walls Model を使用して、滑り条件(非連続体近似)を Wall 境界に設定することが出来ます。このモデル

は、MO タブ（MO→Adv→Slip Walls）で設定でき、Flow, Heat Transfer のモジュールに適用されます。 

以前の CFD-ACE+ のバージョンでは、”Slip Walls” モデルは、解析領域内の全ての Wall 境界に対して自

動的に適用されていました。しかし、V2010.0 では、”Slip Walls” を適用する Wall 境界を BC タブの下で選

択することが出来る様になりました。これによって、ユーザーは、1 つの解析領域内で、流れの性質に応じて

条件を使い分けることが出来ます。 

Slip Walls Model を境界毎に指定するためには次の手順で行います。MO タブにおいて、Slip Walls Model を

有効にすると、Slip Walls の境界条件が、全ての Wall 境界及び Solid-Fluid interface に適用されます。この

動作は、以前のバージョンと同じです。V2010.0 からは、BC タブの Subtype より個々の Wall 境界に対して、

Slip Model を No-slip Model に変更することが出来ます。Slip Wall Model の境界条件は、Moving Wall や、

Rotating Wall にも適用することが出来ます。 

 

Wall 境界条件の拡張 – Inviscid（完全流体）条件                                                               

V2010.0 の Wall 境界条件に新しく Sub-type が追加され、GUI から 3 つの Sub-type が選択できます。これ

らの Sub-type は (i) No-slip (滑り無し)条件, (ii) Inviscid (完全流体)条件, (iii) Slip (滑り)条件もしくは、

Partial-slip 条件の 3 種類です。今後、更に幾つかの Sub-type が追加される予定です。  

No-slip Sub-type は、Wall 境界の通常の扱い方で、以前のバージョンでは、これがデフォルトとなっています。

Inviscid Sub-type は、新しい境界条件です。この境界条件は、ユーザーに粘性を無視した壁面の影響を考

慮でき、いくつかの応用が可能です。Inviscid 境界条件は、壁に対して法線方向の局所的な流速成分に対し

てだけ制約を課して、接線方向の局所的な流速成分に対しては、制約を課しません。この新しい境界条件は、

Symmetry 境界と同等であり、Flow Module のせん断応力無しの条件とも同等です。この条件は、Slip Walls 

Model とは併用できませんが、全ての流れ場の計算において使用できます。Slip Walls Model 使用時は、

No-Slip か、Partial slip の条件のみ選択できます。 

以前のバージョンでは、Inviscid 壁面の効果を得るために Symmetry 境界条件を用いていました。しかし、

Symmetry 境界条件は Flow にのみ適用したくとも、連成問題においては、全てのモジュールに適用されてし

まいます。この Inviscid 条件では、Flow モジュールに対してだけ、Inviscid 条件を課し、その他のモジュール

に対しては異なる境界条件を課すことで、Symmetry 条件による制約を回避することが出来ます。 

この新しい Wall 境界条件は次のように設定します。全ての境界条件は、デフォルトでは、No-slip 条件(局所

的な流体の流速と温度は、それぞれ局所的な壁面の流速と温度と同一であることを強制する条件)が設定さ

れています。ユーザーは、BC タブの Sub-type からそれぞれの Wall 境界条件を Inviscid Sub-type に設定

することが出来ます。この様にして、ユーザーは No-slip, Inviscid 境界を自由に設定することが出来ます。上

記の様な手順が、最も便利で、下位互換性を保つためにもトラブルが尐ない方法です。 

Inviscid wall 境界条件は、Flow モジュールに対してのみ”Full Slip”（完全流体）条件として課すことが出来、

その他のモジュールには使用できません。例えば、Slip Walls による温度ジャンプなどの現象は、この機能で

はモデル化できません。それ故、ユーザーは、この Sub-type を使用したとき、オイラー方程式を解く事には

なりません。Inviscid 使用時でも CFD-ACE+ では、流体場は粘性流体として扱っており、Navier-Stokes 方

程式を解きます。 
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Mass Flow Balance Summary 出力機能の改善                                                 

CFD-ACE+ Solver は、全てのサーフェス上の質量流束の積分値を Summary data として出力することが出

来ます。これらのサーフェスには、Inlet, Outlet, Fluid-Fluid interface, Wall, Thin-wall, Solid-Fluid interface が

含まれます。Wall, Thin-wall 境界と Fluid-Solid 境界においては、質量流束は、質量の生成もしくは消失が反

応やその他の輸送機構によって境界上で起きているときに限って、生じます。Summary data は、ボリューム 

における質量ソースもしくは、シンクによる生成もしくは消失した質量も含みます。質量流束のサーフェス上で

の積分値（そのサーフェスを通過する質量流量の合計として算出される）は、直接それ自身を求めたい計算

結果として使用することも出来ますし（例えば、装置のある部分を通過する質量流量を求めたい解析の場合

は、Mass flow balance summary の出力結果から直接確認出来ます。）、補助的な結果として利用することも

出来ます。Mass flow balance summary は、計算領域内での生成と消滅量のネットバランス（総量）、境界を

通過する質量流量とネットバランス、流入、流出量の相対値等が出力され、計算の収束性の程度を示す指標

として使用できます。 

V2010.0 では、Mass flow balance summary 出力は、より詳しく、便利な Summary data に改善されました。

CFD-ACE+ Solver の以前のバージョンからの重要な変更点は以下です。 

 Boundary-by-Boundary output は、以前のバージョンで使用されていた Key number 表示に変わっ

て、Surface ID で表示されるようになりました。以前と同様、境界名も表示されます。Surface ID は

従来の Key number による認識方法に代わって、ACE+ Suite における新しいサーフェスやボリュー

ム の認識及び追跡方法です。従来どおり、ユーザーは、CFD-ACE+ GUI 上で、境界に名前をつけ

ることが出来、これらの名前を Summary output に反映することが出来ますが、Key number は表

示されず、Surface ID が表示されます。Key number の表示を行いたいユーザーに対しては、モデ

ル中の全境界に対し、Key と Surface ID の対応表を出力するオプションが追加されました。 

 Fluid-Fluid interface を通過する質量流量が、Total Mass Flow Rate Summary にて出力されます。 

 グループ化された境界を通過する質量流量は、グループ全体の質量流量として出力されます。その

為、ユーザーは、GUI 上でグループ化し、名前をつけることで、Summary に出力される情報もグル

ープ化して出力することが出来ます。例えば、モデルに含まれる Inlet 全てをグループ化すると、含

まれる Inlet 個々の流量を足し合わせたグループ全体の流量として、Summary に出力されます。 

 Mass flow balance summary output は、並列計算等のためのドメインの分割に依存しなくなりました。

特に、CFD-ACE+ Solver の以前のバージョンとは異なり、境界がドメイン分割機能によってスプリッ

トされて、一つ一つの断片が並列計算の異なるプロセッサに割り当てられている場合であっても、こ

れらの断片を合計した流量のみが Summary に出力される様になりました。但し、領域分解が計算

領域で既存の Fluid-Fluid interface を生成、削除、変更が可能なため、上記の取り扱いが必ずしも

出来る訳ではなく、この場合 Interface の出力に影響する場合が在ります。 

 Mass flow balance summary デ ー タ は 、 ”modelname.out” 名 の フ ァ イ ル で は な

く、”modelname.MASSUM”名の独立したファイルに出力されるようになりました。Volume のある部

分や、マスバランス全体に対する Summary data は、以前と同様、”modelname.out” ファイルに出

力されます。 

 出力ファイルは、読みやすく、スクリプト処理がしやすい様に、体系化されたフォーマットになりました。 

 

Mass flow rate balance summary の出力（及び Key と Surface ID の対応表の出力）は、以前のバージョンと

同じ様に、GUI 上で有効にし、制御できます。しかし、以前と異なり、Summaries タブが別に用意され、そこに

全ての必要なオプション(Key number の対応表など)が纏められています。 

 

Energy Flow Balance Summary 出力機能の改善                                          

CFD-ACE+ Solver は、サーフェスにおける熱流束の積分値の Summary data を出力しますが、これらの熱

流束には、熱伝導、熱伝達、輻射からの寄与が含まれます。通過する熱流束を計算、積分、出力するサーフ

ェスは Inlet, Outlet, Wall, Thin-wall, Fluid-Solid interfaces から構成されます。この Summary data は、ヒート

ソースやヒートシンクによるボリューム内の熱生成・消滅量も含まれます。この様なソースやシンクは、ユーザ
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ー自身定義によるもの、若しくはその他の現象（Flow, Heat, Chemistry, Spray, Electro-Magnetics, Plasma, 

など）に起因するものがあり得ます。熱流束の Surface 上での積分値（その Surface を通過する熱流束の合

計として算出される）は、直接それ自身を求めたい計算結果として使用することも出来ますし（例えば、装置の

ある部分を通過する熱量を求めたい解析の場合は、Heat Transfer Summary の出力結果から直接確認出来

ます。）、追加の補助的な結果として利用することも出来ます。Energy flow balance summary には、計算領域

内での熱生成・消費量と境界を通過する熱量のネットバランス（総量）、熱流入・流出の相対値等が出力され、

計算の収束性の度合いを示す指標として使用できます。 

V2010.0 では、Energy flow balance summary 出力機能がより詳しく、便利なサマリーデータとして改善されま

した。CFD-ACE+ Solver の以前のバージョンと比較して、重要な変更点は以下に記します。 

 Boundary-by-Boundary output は、以前のバージョンで使用されていた、Key number 表示に変わ

って、Surface ID で表示されるようになりました。もちろん、以前と同様に、境界名も表示されます。

Surface ID は、従来の Key number による認識方法に代わって ACE+ Suite における新しい

Surface や Volume の認識及び追跡方法です。従来どおり、ユーザーは、CFD-ACE+ GUI 上で、

境界に名前をつけることが出来、これらの名前を Summary output に反映することが出来ますが、

Key number は表示されず、Surface ID が表示されます。Key number の表示を行いたいユーザー

に対して、モデル中の全境界に対し、Key と Surface ID の対応表を出力するオプションが追加さ

れました。 

 グループ化された境界を通過する熱量は、グループ全体の熱量として出力されます。その為、ユー

ザーは、GUI 上でグループ化し、名前をつけることで、Summary に出力される情報もグループ化し

て出力することが出来ます。例えば、モデルに含まれる Inlet 全てをグループ化すると、含まれる

Inlet 個々の熱量を足し合わせたグループ全体の熱量として、Summary に出力されます。 

 Energy flow balance summary output は、並列計算等のためのドメインの分割に依存しなくなりまし

た。特に、CFD-ACE+ Solver の以前のバージョンとは異なり、境界がドメイン分割機能によってスプ

リットされて、一つ一つの断片が並列計算の異なるプロセッサに割り当てられている場合であっても、

これらの断片を合計した流量のみが Summary に出力される様になりました。但し、領域分解が計

算領域で既存の Fluid-Fluid interface を生成、削除、変更が可能なため、上記の取り扱いが必ずし

も出来る訳ではなく、この場合 Interface の出力に影響する場合が在ります。 

 Energy flow balance summary デ ー タ は 、 ”modelname.out”  名 の フ ァ イ ル で は な

く、、”modelname.ENGSUM”名の という独立したファイルに出力されるようになりました。ボリューム

のある部分に対する Energy flow balance data やエネルギー収支全体の情報は、以前と同様

に、”modelname.out” ファイルに出力されます。 

 出力ファイルは、読みやすく、スクリプト処理がしやすい様に、体系化されたフォーマットになりました。 

Energy flow rate balance summary の出力（及び Key と Surface ID の対応表の出力）は、以前のバージョン

と同じ様に、GUI 上で有効にし、制御できます。しかし、以前と異なり、Summaries タブが別に用意され、そこ

に全ての必要なオプション(key number の対応表など)が纏められています。 

 

結果の出力頻度指定オプションの拡張                                                                                   

V2010.0 では、Output Control オプションが新たに設けられ、DTF ファイルに書き込まれる情報の頻度と

Output や Summery ファイルへの出力頻度を別々に指定できるようになりました。DTF ファイルへの書き込み

はリスタート用データ（セルセンターのデータ）とグラフィック用データ（ノードデータ）を含みます。 

ユーザーは、通常の出力頻度（以前のバージョンの Output Frequency）を指定し、その後、Restart, Graphic, 

Summaries でそれぞれ異なる出力頻度を指定したい場合には、”Override General Output Controls” にチェ

ックを入れて指定します。この”Override options/controls” は、解析中の出力頻度をより効率よく指定できま

す。このオプションは、定常・非定常の両方で使用できます。 
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VOF モジュール – 表面張力によるマランゴニ効果モデルの追加                                                  

表面張力係数 σ  が 2 種類の非混合流体の境界面に沿って変化する場合、通常この変化により境界面の

接線方向の合力が発生し、この接線分力は、境界面に接する流体境界に沿った流れを引起します。この表面

張力が引き起こす接線分力と動きは、マランゴニ効果と呼ばれています。表面張力の成分は、境界面の接線

成分と法線成分です。この法線成分は、その変化に関わらず、表面張力が生じるところには常に存在します。

そして境界面を挟んで圧力のジャンプを引き起こし、境界面に垂直方向の動きを引き起こします。 

V2010.0 では Marangoni Effects Model が、追加されました。このモデルは、MO パネルの VOF モジュール、

Surface tension model オプションの下で有効にすることが出来ます。CFD-ACE+では、マランゴニ効果を引

起す表面張力係数を温度、化学種濃度、またはユーザサブルーチンで参照できる他の物理量依存にする事

ができます。 

VOF モジュール – 並列計算の改善                                                                         

V2010.0 では、VOF モジュールの Face-pressure の内挿とプロセッサ間分割領域インターフェースでのデー

タのやり取りの精度が向上しました。これらの 2 つの改善結果により、重力場と表面張力のカップリングにお

いて並列計算分割領域境界を横切る VOF 関数の輸送に対する精度が向上しました。結果として、VOF モジ

ュールにおける並列計算の精度とパフォーマンスが向上しました。 

 

領域分割の並列処理機能の追加と実行コマンドの変更                                                                   

V2010.0 とそれ以前のバージョンでは、ドメイン分割は、DTF ファイルを指定した手法で指定したゾーン数に

分割するために dtf_decompose スクリプトを実行により行われていました。この分割プロセスは、1 つのプロ

セッサ（逐次処理）でのみ行われていました。V2010.0 では、シリアルもしくは並列でドメインの分割を行うこと

が出来る新しい Decompose スクリプトが導入されました。 

コマンド：CFD-Decompose [options] 

コマンド実行の基本(シリアルモード)： 

CFD-Decompose --dtf=model.DTF --numZones=Nzones 

        シミュレーション番号 1 を、N 個の Zone（Nzones） にシリアルコードで分割 

 

コマンド実行の基本(並列モード)： 

CFD-Decompose --dtf=model.DTF --numZones=Nzones --dmp --numProcs=Nprocesses 

        シミュレーション番号 1 を、N 個の Zone（Nzones） に N 個のプロセッサ（Nprocesses）を用いて DMP

モードでローカルマシン上で分割  

        (カレントフォルダは、作業フォルダで、ローカルマシンのみで実行する場合). 

 

スクリプトに関するその他の情報は、CFD-ACE+ V2010.0 ユーザーマニュアルを参照してください。 

 

CFD-SOLVER の並列計算の改善と実行コマンドの変更                      

過去のリリースにおいて、CFD-ACE+では、MPICH, HP-MPI, その他の native MPIs など、いくつかの MPI

（Message Passing Interfaces） をサポートしてきました。これらの以前のバージョンでは、MPI のライブラリは、

CFD-ACE-SOLVER と強く関連しており、個々の MPI ライブラリ（e.p. CFD-ACE-SOLVER-MPICH-MPI, 

CFD-ACE-SOLVER-HP-MPI, etc…）で実行方法が異なっていました。V2010.0 からは、MPI が動的に呼ば

れるようになりました。つまり、1 つのソルバーを実行する際に MPI のライブラリを選択できるようになりました。 
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その為、以前の並列計算のスクリプトである、cfd-ace-mpi は、現在サポートされていません。以前の方法を

使用する場合には、V2009.4 のソルバー使用してください。 

 

シリアル計算をサポート 

以前のバージョンでは、並列スクリプト（cfd-ace-mpi または、CFD-SOLVER） は、例えば並列計算のプロセ

ス数が 1（シリアル）であっても、MPI の実行ファイル(CFD-ACE-SOVER-HP-MPI など)を用いていました。 

この方法は MPI に関する計算コストを追加してしまいます。V2010.0 では、これらの計算コストが削除されま

した。ほぼ全てのユーザにおいて使用上の変化はありません。 

実行コマンド例: 

CFD-SOLVER –dtf filename.DTF 

 

全てのプラットフォームで HP-MPI をサポート 

HP-MPI は、Linux プラットフォームでサポートされてきました。Windows プラットフォームは、V2009.4 からサ

ポートされています。V2010.0 においては、HP-MPI は継続して全てのプラットフォームでサポートされていま

す。 

実行コマンド例: 

CFD-SOLVER –dtf filename.DTF –num 2 –hpmpi 

 

Linux プラットフォームで MPICH2 をサポート 

V2010.0 では、MPICH2 のサポートが新しく Linux のプラットフォームに追加されました。MPICH2 は、CFD-

SOLVER スクリプトに “-mpich2” のオプションを使用することで、呼び出せます。 

実行コマンド例: 

CFD-SOLVER –dtf filename.DTF –num 2 –mpich2 

ユーザーは、MPICH2 を使用する際に、追加のソフトをインストール必要はありませんが、いくつか必要な設

定項目があります。 

“secret word”が登録されているか確認: 

MPICH 2 を使用する際に、異なるユーザーの mpd プロセスを区別するために、”secret word” が必要になり

ます。この”secret word” は、自身のホームディレクトリの中に、オーナーのみ読み書き可能で他の使用者が

利用できないパーミッションの.mpd.conf ファイルに保存する必要があります。Secret word の指定は任意で

すが、自身のパスワードを使用してはいけません。これは、全てのノードにおいて行う必要があります。 

コマンドプロンプトから、以下のコマンドを行います。 

$ echo “MPD_SECRETWORD=xxxxxx” > $HOME/.mpd.conf 

$ chmod 600 $HOME/.mpd.conf 

“xxxxxx” は、使用者が指定した”secret word” です。 

もし、ルート権限で実行する際には、/etc/.mpd.conf を同じ様な内容とパーミッションで作成してください。 

 

注意: SELinux ファイルのコンテクスト設定 

セキュリティを強化した Linux （SELinux）を使用している場合には、CFD-ACE+ ライブラリがよみこまれないと

いう問題が報告されています。これを避けるために、SELinux の場合には、CFD-ACE+ のライブラリが読み

込まれる様に設定します。その方法の１つを以下に示します。 
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コマンドプロンプトから、以下のコマンドを行います。 

$ chcon –t textrel_shlib_t $ESI_HOME/2010.0/ACE_SOLVER/lib/*.so 

システム管理者は他の方法で上記を実行できる可能性があります。ライブラリを読み込めない場合には、

SELinux を使わないで下さい。 

 

SF6/O2 プラズマの気相反応モデルの追加 

V2010.0 で、SF6/O2 低温プラズマの気相反応モデルがデーターベースに追加されました。 
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CFD-ACE+ GUI 

CFD-ACE+ GUI V2010.0 V2009.4 リリース以降に開発された新機能と改良した機能をすべて反映しています。

本稿ではこれらについて記載します。 

 

V2010.0 

データベースマネージャーの強化                                                                       

CFD-ACE+ユーザーが使用する Database Manager は V2010.0 で複数の新機能と改良が加えられまし

た。”shared” 階層の追加、フォルダー構成の改良、import/export 機能の追加、ドラッグ&ドロップのサポート、

新しいスクリプト関数です。これらの詳細は Appendix を参照して下さい。 

 

新しいグループのカテゴリーの追加                                                                                          

表面の投影面積の計算等のために、CFD－ACE+ GUI V2010.0 では boundary のグループ化をカテゴリー毎

区別する機能を追加しました、それぞれのカテゴリーは特定の分類で区別されます。これらの boundary グル

ープは Model Explorer で作成することができ、Geometry Tree の ”Group Categories” に表示されます。 

 
 

適応されるカテゴリーは: 

 Projected Area (投影面積) 

 Mass Balance Summary (質量収支) 

 Energy Balance Summary (エネルギー収支) 

 

それぞれのカテゴリーは、Model Explorer にて boundary 名、other Keycategories and groups にて boundary

が属すカテゴリー、Key の番号(CFD-GEO より)と ID(ポストプロセスの summary レポートに使用)が表示され

ます。 

グループカテゴリーの詳細についてはユーザマニュアルを御参照ください。 

修正された問題 - V2010.0 

以下のリストは V2009.0 以降に修正された問題です。 
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 Solver 

Fixed in V2010.0: 

o 表面反応式で使用した化学種名が化学種リスト中にない場合、ソルバーを停止させるエラ

ーチェックが加わりました。 

o DTF ファイルからノード点データ取出し時のエラーが修正されました。 

o 小規模モデルにおいて出力ファイルに書き込むコイル電流の単位の誤りが修正されました。 

o リスタート時、モニターポイント出力ファイルへの追加書き込み処理のエラーが修正されまし

た。 

 GUI 

Fixed in V2010.0: 

o Tools-> ‘View DTF Content’ で GUI がクラッシュした点を修正しました。 

o  “Surface Current Dependent” オプションは電気化学反応のみに適応されます。 

o Macro-particle の描画に関連した問題は修正されました。 

既知の問題 

以下は、これまでに確認された問題です。これらは今後修正する予定です。 

 Solver 

o DSMC シミュレーションは複雑形状で正しく計算出来ない可能性があります 

o 電気メッキのリスタート計算において、初期シード層厚みを正しく処理できない場合がありま

す。 

o 理想気体を仮定した気体を含む 2 流体モデルの計算で収束に問題がある場合があります。 

o マクロパーティクルが流出口から流出するとすぐに計算が停止する場合があります。 

o 燃料電池の計算において、触媒層の境界が並列計算の分割境界になっている場合、正常

に動作できない場合があります。 

o Flow 及び Turbulent モジュールでカイメラ格子を使用している場合にメモリーリークの問題

があります。 

o Arbitrary Interface を横切り、僅かに圧力が上昇する場合があります。 

o 二相流モジュールにおいて、流れのボリュームソースが正常に動作しない場合があります。 

o 32bit MS-Windows 環境下 、2 ゾーン以上の並列計算において、HP-MPI のアクセス違反を

引き起こす事があります。回避方法としてコマンドラインから並列計算を実行するときに、ユ

ーザーは下のオプションを CFD-SOLVER のスクリプトに使用してください。 

 --hpmpi  

 --solver=$ESI_HOME/2010.0/ACE_SOLVER/bin/CFD-ACE-SOLVER-HP-MPI.exe  

 --wmserver=$ESI_HOME/2010.0/ACE_SOLVER/bin/wmServer-HP-MPI.exe 

CFD-ACE+ GUI からは並列計算を実行する場合、ユーザーはこれらの HP-MPI 実行モジ

ュールは Edit->Preference->Tools->Solver で指定する必要があります。 

 

 GUI 

o ドラッグ&ドロップが Windows 64-bit 版で動作しません。 
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CFD-FASTRAN V2010.0 
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新機能と改良点 

CFD-FASTRAN Solver 

CFD-FASTRAN Solver V2010.0 は、V2009.4 リリースから、新機能の追加と機能の改良を全て含みます。

これら新機能と改良点を以下に紹介します。 
 

V2010.0 

サポートする全てのプラットフォームでの Polyhedral ソルバの HP-MPI 対応                                

サポートする全てのプラットフォーム上で HP-MPI ライブラリを使用できる実行モジュールが V2010.0 に追加

されました。 

V2010.0 以前の CFD-FASTRAN の polyhedral ソルバでは、MPI 標準規格として MPICH1.2 ライブラリを

使用しました。V2010.0 では、ここ数年にわたる MPI 標準規格での多数の改良を利用するために、

MPICH1.2 ライブラリを HP-MPI ライブラリに置き換えました。HP-MPI ライブラリを利用するために必要な全

てのソフトウェアが UTILS パッケージに含まれていますので、追加のソフトウェアをユーザがインストールす

る必要はありません。これは Linux と Windows プラットフォーム両方に該当します。HP-MPI ライブラリのバ

ージョンは 1.01.00.00（Windows プラットフォーム）、2.03.01.00（その他のプラットフォーム）になります。 

追加のセットアップ 

Linux プラットフォーム：以下の追加のセットアップを推奨します。 

1. パスワードレス SSH の設定 

2. NFS（Network File System）の構築 

 

Windows プラットフォーム：複数のノード上での（分散メモリ型）並列計算を実行する際、以下の追加のセット

アップが必要です。 

1. HP-MPI remote launch service のインストールと開始 

2. HP-MPI プログラムをファイアウォールの例外処理として追加 

3. 認証用パスワードの登録 

詳しくは CFD-FASTRAN ユーザ・マニュアル、もしくは Getting started ガイドをご参照ください。 

 

使用方法： 

並列計算ジョブのセットアップと起動方法に変更はありません。以前のバージョンと同様に、並列計算ジョブの

起動に CFD-FASTRAN-SOLVER スクリプトを使用します。並列計算に関する設定（ホストと作業ディレクトリ

の指定）は CFD-FASTRAN-GUI 上で行います。 

 

推奨する使用方法： 

ステップ 1： 

dtf_decompose ユーティリティ・プログラムを使って、（DTF ファイルを）並列計算に使用するプロセス数に領

域分割します。 

Usage: dtf_decompose –file_out <newfile.DTF> <origfile.DTF> <sim #> <# of parallel processes> 
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例： 

$ dtf_decompose –file_out newfile.DTF origfile.DTF 1 2 

ステップ 2： 

CFD-FASTRAN-SOLVER スクリプトを実行します。 

Usage: CFD-FASTRAN-SOLVER –dtf <newfile.DTF> -nodecomp 

例： 

$ CFD-FASTRAN-SOLVER –dtf newfile.DTF –nodecomp 

 

Structured Grid ソルバ用の並列計算スクリプトの改良                  

CFD-FASTRAN を使用した並列計算では、計算実行中の通信とデータ転送用に、ホスト（MDICE registry, 

daemon, controller）とリモート・ノード（MDICE daemon）上での複数の MDICE プロセスの起動が必要です。

これらのプロセスは CFD-FASTRAN-SOLVER スクリプトによって自動的に起動されます。 

V2009.4（リリース）に先立って、ある特定の Linux システム上で PBS などのジョブ管理システム、もしくは

CFD-FASTRAN-GUI を介した並列計算ジョブの起動に障害が生じました。このシステム上では、並列計算

の実行開始前に複数の MDICE プロセスを手動で起動する必要がありました。V2009.4 では、MDICE プロ

セスが適切に起動されていることを確認するために、CFD-FASTRAN-SOLVER の並列計算ジョブの起動ス

クリプトに多数の機能改良を行いました。これらの改良により、追加の手動操作を行うことなくスクリプトを介し

て直接 CFD-FASTRAN の並列計算ジョブの起動が可能になりました。 

V0210.0（リリース）に先立って、特に複数のノード上で（分散メモリ型）並列計算ジョブを実行する場合、幾つ

かの課題が Windows 64bit 計算機上で見付かりました。このシステム上では、ユーザは並列計算プロセスを

手動で起動する必要がありますが、この結果としてシミュレーションの最後の段階で DTF ファイルの結合に

失敗します。V2010.0 では、これらのエラーを回避するために多数の機能改良が CFD-FASTRAN-SOLVER

の並列計算の起動スクリプトに行われています。 

以下のオプションが CFD-FASTRAN-SOLVER スクリプトに追加されています。 

 
-keep 全てのノード上で中間ファイル（DTF ファイル）を保持し、削除しません。 

初期設定では、CFD-FASTRAN-SOLVER スクリプトは、中間ファイル（DTF ファイル）を結

合し、もとのファイルに書き込んだ後、シミュレーションの最後に中間ファイル全てを削除し

ます。結合操作に失敗した場合、以前の（バージョンを使用する）ユーザは DTF ファイルに

アクセスできませんでした。このオプションを使用しますと、もし結合操作に失敗しても

par_util ユーティリティ・プログラムを使ってファイルの結合ができますので、ユーザは DTF

ファイルへのアクセスが可能になります。 

  
-unix Windows 計算機上で cygwin 向けの unix コマンドを有効にします 

  
-gui  MDICE GUI を起動します 

 
 

コマンドプロンプトから CFD-FASTRAN-SOLVER を入力しますと、利用できる全てのオプションのリストを表

示できます。 
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CFD-FASTRAN GUI 

CFD-FASTRAN GUI V2010.0 は V2009.4 リリース以降の新機能の追加と機能の改良を全て含みます。 

CFD-FASTRAN ソルバの新機能を有効にする、もしくはサポートするために必要な開発も含まれています。 
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修正済みの問題 

V2010.0 リリースで修正済みの問題を以下に列挙します。 

 Solver 

Fixed in V2010.0: 

o BC に関連する問題（コードがハングする）を修正しました 

o T
+
の計算に関連して、k-ε 乱流モデルを等温規定の壁面と併用した場合に結果として NaN

が生じる問題を修正しました。 

o CFD-FASTRAN の起動スクリプトに関連する問題を修正しました。MPI-based の並列計算

が rhe4（32bit と 64bit）、及び rhe5（32bit と 64bit）プラットフォーム上で実行できます。 

o （CFD-FASTRAN と CFD-ACE+の thermal coupling を使用した）再突入（re-entry）中の

機体表面の熱流束の計算にエラーがありました。この thermal coupling に使用するユー

ザ・サブルーチンを修正しました。 

o CFD-FASTRAN ソルバの並列計算モードを手動で起動した場合、DTF merge ユーティリ

ティが動作しません。scp.exe に設定する際に、環境変数’FASTRAN_RCP’を導入すること

で、この問題を解決しました。 

o Windows 計算機上での並列計算の実行において、多数の改良を行いました。CFD-

FASTRAN-SOLVER に以下のオプションを追加、更新しました。 

-keep：（全てのノード上で）中間ファイル（DTF ファイル）を削除しません 

-unix： Windows 計算機上で cygwin 向けに unix コマンド全てを有効にします 

-gui: MDICE gui が起動します 

 

既知の問題 

このリリースにおける致命的な既知の問題は以下になります。これらの問題は今後のリリースにて修正される

予定です。 

 Solver 

o 中間ファイルを保存するオプションを使用して非定常の FSI シミュレーションを実行する場

合で、且つ CFD-ACE+ソルバのリリースバージョンを使用する場合に計算が即座に終了し

ます。（この問題は CFD-ACE+ソルバのβ バージョンで修正されています。） 

 

 GUI 

o Windows 64bit システム上でドラッグ&ドロップが動作しません。 
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新機能および改良点 

CFD-VIEW V2010.0 は、V2009.4 リリース以降に行われたバグ修正と改良を全て含む、V2010.0 の最

初のリリース版となります。以下に、V2010.0 に加わった新機能と変更点を記述します。  
 

V2010.0 

セル中心値での表示                                                                      

以前のバージョンの CFD-VIEW で表示される物理量はソルバーによりノード点に変換されたデータ

のみでしたが、V2010.0 ではセル中心データも表示/ポスト処理が可能となりました。 

セル中心値は DTF ファイルから CFD-VIEW に読込まれます。 セル中心データとノード点上のデータ

の判別は変数名で行われ、DTF から読まれたノード点データは "Nodal_"、セル中心データは 

"Cell_"と表示されます。 読込まれたセル中心のデータを使用し、Iso Surfaces, XYZ / IJK cuts, 

traces, line probe, point probes, point nets, stripcharts および point history 等ポストプ

ロセスが可能です。 

Colored Surface Display モードでセル中心データの表面カラーマップが表示されます。セル中心デ

ータで表示した場合、Flood 表示、Smooth 表示は colored 表示に切り替わります。 

 

Nodal and Cell-center (bottom-right) data Visualization 

 

以下の機能はセル中心データに対応していません: 

 Calculator 

 IJK, XYZ および Iso Lines 

 MinMax Probe 

 Carpet Plot 

 DTF ファイルからインポートした 3D ボリュームメッシュのサーフェスにはセル中心データ

がありません。但し、Border operator を使用し、セル中心データを持つサーフェス作成す

ることは可能です。 
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修正済みの問題 

V2010.0 リリースで修正済の問題を以下に列挙します。 

 V2010.0.17 で作成されたモデルファイルに不具合があり、読込時に CFD-VIEW は強制終了します。

この問題は修正されましたが、このバージョンで作成されたモデルファイルは開くことができないため、

作成し直す必要があります。 

 V2010.0 ベータバージョン では V2007 以前のポイントプローブを含むモデルファイルを読み込むと

強制終了します。この問題は修正されました。 

 最初のオブジェクトがデータを持たないオブジェクトであった場合カラーマップが更新されない問題が

修正されました。 

 MinMax Probe の min/max mode を設定するための機能がスクリプトに追加されました。  

o 例:  

probe=CreateMinMaxProbe(GetAllVolumes())  

SetProbeVariable(probe,"VonMises")  

# To set to minimum mode: 

SetMinMaxProbeDisplay(probe,PROBE_DISPLAY_MINIMUM) 

# To set to maximum mode: 

SetMinMaxProbeDisplay(probe,PROBE_DISPLAY_MAXIMUM) 

 GetProbePosition() は MinMaxProbeでも使用できます。   

o 例:  

probe = CreateMinMaxProbe(GetAllVolumes()) 

SetProbeVariable(probe,"VonMises")  

print GetProbePosition(probe) 

 

既知の問題  

以下は最新バージョンでの既知の問題です。これらの問題は以降のリリースで修正される予定です。  

 X-サーバの起動無しに Linux/Unix 上で CFD-VIEW を起動した場合（例えばリモートクラスタ中のノ

ードで実行する場合）、幾つかのシステムフォントが headless モードで使用できません。X サーバを

起動すれば、本問題は解決します。 

 Windows 64 ビットシステム上で “Headless” CFD-VIEW は現在使用できません。  
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データベースマネージャーの改善  

V2010.0、データベースマネージャーの新規・拡張機能について記述します。 

共有データベース                           

V2010.0 では、新たに共有データベース階層が導入されました。本階層は使用者間で共有するデータをリモ

ートマシン上に保存する目的で追加され、共有 DB の保存場所は Edit ->Preferences->Database (デフォルト

は空)で指定します。共有 DB 名の指定が無い場合、shared-ace.sdb ファイルが尐なくとも参照権限を許可し

ていない場合、使用者は DB マネージャにて共有レベルの DB を参照する事ができません。 

共有 DB は通常変更不可になっています。意図しない変更を防ぐために共有 DB は書込み権限を不可にする

ロック機構を持っています。デフォルトではロック機構はオンになっており、変更は階層構造の共有 DB を右ク

リックで Unlock を選択して行います。これで共有 DB は書込み可になります。必要な修正後は、右クリック-

>Lock にて再度書込み不可モードにします。同様の操作は Python スクリプト関数を使用し行う事ができます。 

GuiDBM.SetSharedLock(True) # Locks level 

GuiDBM.SetSharedLock(False) # Unlocks level 

注:他の使用者が shared-ace.sdb への書込み権限を使用している場合、 ロック機能はグレーアウトしていま

す。 

 

フォルダー構成の改良 

階層構造中のデータベースレベルは以下に分類されます。 

Model 

本階層は model として分類され DTF ファイルからロードされたものです。いつでも修正可能です。 

Local 

ローカルアイテムは@symbol と表示されません。階層構造上別分類となります。 

この階層のユーザーアイテムは通常ローカルのマシーンに保存され、保存場所は Edit->Preference-

>Database で指定します。いつでも修正可能です。 

Shared 

本階層は使用者間で共有でき、リモートのマシーンに保存され、保存場所は Edit->Preference->Database で

指定します。ロックを解除して修正します。 

ESI 

本階層は開発元提供のデータです。変更できません。 

注: 使用者が変更不可階層(ESI やロックされている Shared) データの変更を行いたい場合は、Local レベル

にデータをコピーして変更します。 

モデル全体のエクスポート                                                                                                 

V2010.0 では Model の中の全てのアイテムが簡単な方法でエクスポートできます。ツリー構造中の対象

model を右クリック、エクスポートを選択すると、”Export all model items”のダイアログが表示されます。エクス

ポートするファイル名を選択、又は新たに作成するファイル名を入力し、OK をクリックします。 

注: この機能は.sdb 形式にのみ対応しています。 
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特定の階層のインポート                                                                                       

V2010.0 以前では、インポート操作は Local 階層にのみ対応していました。V2010.0 では.sdb ファイルを全て

の書込み可 DB 階層（Model、Local、ロック解除した Shared）にインポートできます。ツリー構造中のインポー

トする階層を右クリック、import を選択すると、新たにインポートしたアイテムが選択した階層に現れます。 

注: この機能はスクリプトの実行のみで、Python でのインポートには対応できません。 

 

ドラッグ&ドロップ                                                                                                       

V2010.0 ではデータベース中のアイテムのコピーや移動はドラッグ&ドロップによって行うことが可能です。対

象アイテムを選択してそれらを目的のフォルダーにドラッグしてマウスのボタンを離します。アイテムのコピー

には Ctrl キーを押して、移動は押さずに行います。 

注: アイテムをデータベースの階層を横切ってドラッグ&ドロップすることが出来ますが、アイテムの全選択は

同じ階層から行わなければいけません。 

 

付随アイテムのコピー                                                                   

V2010.0 では Reaction や Mixtures をコピーした時、付随する全ての component(Species, Surface Site 等)も

自動的にコピーされます。 

 

新しいスクリプト関数                                                                                        

GuiDBM.Import(from_filename, to_level=0, to_model='') 
- ファイルから指定した階層/モデルにインポートする 

GuiDBM.ExportModelItems(from_model, to_filename, append=False) 
- モデルの全てのエンティティへ指定したファイルへエクスポートする 

GuiDBM.SetSharedLock(True) # Locks level 
- 共有 DB のロック/ロック解除を行う。 

 

 

 

 

 

 





 

 



 

 

 


